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Q1: What are the four fundamental parts of computer? Explain it with the help of diagram. 
Input device:- an input device is a piece of equipment used to provide data and control signals 
to an information processing system such as a computer or information appliance. Examples of 
input devices include keyboards, mouse, scanners, [[digital camera] The]s, joysticks, and 
microphones. 
Central processing unit(CPU):-  central processing unit (CPU), also called a central 
processor, main processor or just processor, is the electronic circuitry within a computer that 
executes instructions that make up a computer program. The CPU performs basic arithmetic, 
logic, controlling, and input/output (I/O) operations specified by the instructions in the 
program. The computer industry used the term "central processing unit" as early as 1955. 
Primary Memory:- Primary memory is computer memory that is accessed directly by the CPU. 
This includes several types of memory, such as the processor cache and system ROM. However, 
in most cases, primary memory refers to system RAM. 
Output:- An output device is any piece of computer hardware equipment which converts 
information into human-readable form. It can be text, graphics, tactile, audio, and video. Some 
of the output devices are Visual Display Units i.e. a Monitor, Printer, Graphic Output devices, 
Plotters, Speakers etc. 
Q2: Discuss about the classification of computers based on size and capacity? 
Classification of computer based on size and capacity:- 
 Microcomputer (pc) 
  
A microcomputer is the smallest general purpose processing system. The older pc started 8 bit 
processor with speed of 3.7MB and current pc 64 bit processor with speed of 4.66 GB. 
Examples: -     IBM PCs, APPLE computers 
b) Minicomputer: - A minicomputer is a medium-sized computer. That is more powerful than a 
microcomputer. These computers are usually designed to serve multiple users simultaneously 
(Parallel Processing). They are more expensive than microcomputers. 
Examples:  Digital Alpha, Sun Ultra. 
 
c) Mainframe computers: - Computers with large storage capacities and very high speed of 
processing (compared to mini- or microcomputers) are known as mainframe computers. They 
support a large number of terminals for simultaneous use by a number of users like ATM 
transactions. They are also used as central host computers in distributed data processing 
system. 
Examples: -     IBM 370, S/390. 
d) Supercomputer: -      Supercomputers have extremely large storage capacity and computing 
speeds which are many times faster than other computers. A supercomputer is measured in 
terms of tens of millions Instructions per second (MIPS), an operation is made up of numerous 
instructions. The supercomputer is mainly used for large scale numerical problems in scientific 
and engineering disciplines such as Weather analysis. 
Example- IBM Deep Blue. 
 

https://en.wikipedia.org/wiki/Electronic_circuit
https://en.wikipedia.org/wiki/Computer
https://en.wikipedia.org/wiki/Instruction_(computing)
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Q3: What is the meaning of computer generation? How many Computer Generations are 
defined? What technologies were/are used? 
Generation in computer terminology is a change in technology a computer is/was being used. 
Initially, the generation term was used to distinguish between varying hardware technologies. 
Nowadays, generation includes both hardware and software, which together make up an 
entire computer system. The first integrated circuits contained only a few transistors and so 
were called “Small-Scale Integration (SSI). They used circuits containing transistors numbering 
in the tens. They were very crucial in development of early computers. SSI was followed by 
introduction of the devices which contained hundreds of transistors on each chip, and so were 
called “Medium-Scale Integration (MSI)MSI were attractive economically because which they 
cost little more systems to be produced using smaller circuit boards, less assembly work, and a 
number of other advantages.  
Microprocessor chips produced in 1994 contained more than three million transistors. ULSI 
refer to “Ultra-Large Scale Integration” and correspond to more than 1 million of transistors. 
However there is no qualitative leap between VLSI and ULSI, hence normally in technical texts 
the “VLSI” term cover ULSI. 
Q4: Differentiate between Volatile & Non- Volatile memories. 

s.no. Volatile memory Non volatile memory 

1. Volatile memory is the type of 
memory in which data is lost as it is 
powered-off. 

Non-volatile memory is the type of memory 
in which data remains stored even if it is 
powered-off. 

2. Contents of Volatile memory are 
stored temporarily. 

Contents of Non-volatile memory are stored 
permanently. 

3. It is faster than non-volatile memory. It is slower than volatile memory. 

4. RAM (Random Access Memory) is an 
example of volatile memory. 

ROM(Read Only Memory) is an example of 
non-volatile memory 

5. In volatile memory, data can be easily 
transferred in comparison to non-
volatile memory. 

In non-volatile memory, data cannot be easily 
transferred in comparison to volatile 
memory. 

6. In Volatile memory, process can read 
and write. 

In Non-volatile memory, process can only 
read. 

7. Volatile memory is more costly per 
unit size. 

Non-volatile memory is less costly per unit 
size. 

 
Q5: Distinguish among system software, application software and open source software on 
the basis of their features? 
System software: - System software is a type of computer program that is designed to run a 
computer's hardware and application programs. If we think of the computer system as a 
layered model, the system software is the interface between the hardware and user 
applications. 
 
 
 



Features of system software:- 
System Software is closer to the system. 
Generally written in a low-level language. 
The system software is difficult to design and understand. 
Fast in speed. 
Less interactive. 
Smaller in size. 
Hard to manipulate 
Application software:- Application software is a program or group of programs designed for 
end users. Examples of an application include a word processor, a spreadsheet, an accounting 
application, a web browser, an email client, a media player, a file viewer, simulators, a console 
game or a photo editor. 
Features of application software:- 
Perform more specialized tasks like word processing, spreadsheets, email, photo editing, etc. 
It needs more storage space as it is bigger in size. 
Easy to design and more interactive for the user. 
Generally written in a high-level language. 
 
Open source software:- Open-source software is a type of computer software in which source 
code is released under a license in which the copyright holder grants users the rights to use, 
study, change, and distribute the software to anyone and for any purpose. Open-source 
software may be developed in a collaborative public manner. 
Features of open source software:- 
Lesser hardware costs. ... 
High-quality software. ... 
No vendor lock-in ... 
Integrated management. ... 
Simple license management. ... 
Lower software costs. ... 
Abundant support. ... 
Scaling and consolidating. 
 
Q6. a) Create a file in MS-word to insert a paragraph about yourself and save it with file name 
“yourself”. Describe all steps involved in it.? 
To open Microsoft Word, click on the Word icon ("W") on the toolbar or desktop. 
An open (and blank) Word document will open on the screen. 
Enter a paragraph about yourself. 
When document is finished, click on "File" on the standard toolbar at the top of screen. 
Click on "Save As." 
 
 
Q6 b) Write steps regarding followings? 
To change the font style  
To change the font size 



To change the font color 
 To highlight (in yellow) the line that reads “need to get IMS’s address”. 
 
Steps to change the font style:- 
Go to Format > Font > Font. You can also press and hold. + D to open the Font dialog box. 
Select the font and size you want to use. 
Select Default, and then select yes. 
Select OK. 
 
Steps to change the font size:- 
Select the text or cells with text you want to change. To select all text in a Word document, 
press Ctrl + A. 
On the Home tab, click the font size in the Font Size box. 
Steps to change font color:- 
Select the text that you want to change. 
On the Home tab, in the Font group, choose the arrow next to Font Color, and then select a 
color. 
Q7. Create a file in MS-Word for the following document and save it with file name ‘msword’. 
Describe all steps involved in it.  
Steps of create a file in ms word:- 
1. The Start button in the lower-left corner of your screen gives you access to all programs on 
your PC—Word included. To start Word: 
 choose Start → All Programs → Microsoft Office → Microsoft office word. 
2. And then enter the data  
MS WORD 
MS WORD is a widely used commercial word processor developed by Microsoft. 
Ms Word is application software, which is capable of 
Creating, 
Editing, 
Saving  
Printing and type of document 
And save this file name "ms word". 
Q8. Create a file in MS-word for the following document and save it with file name 
‘equations’. Describe? 
All steps involved in it. 
 
Choose Insert > Equation and choose the equation you want from the gallery. 
After you insert the equation the Equation Tools Design tab opens with symbols and structures 
that can be added to your equation. 

𝑥2 + 𝑦5 = 30 
 𝑧3 + 𝑞4 = 50 

𝑎2 + 𝑏8 = 𝑦2 + 𝑦8 
 
 



Q9. Create a file in MS-word that convert existing highlight text to table as shown below and 
save it as file name ‘text_to_table’. Describe all steps involved in it. 
START MS WORD? 
1. Click on start button and click then run option run dialog box will be appear o screen. 
2. CLICK START PROGRAM-all programs- Microsoft office word 2007. 
Select the text that you want. 
Select the text that you want to convert, and then click Insert > Table > Convert Text to Table. 
In the Convert Text to Table box, choose the options you want. 
Under Table size, make sure the numbers match the numbers of columns and rows you want. 
Under AutoFit behavior, choose how you want your table to look. Word automatically chooses 
a width for the table columns. If you want a different column width, choose one of these 
options. 
Under Separate text at, choose the separator character you used in the text. 
Click OK.  
Q10. Create a file in MS-Word to insert a table in the document. Describe all steps involved in it. 
Open a blank Word document. 
In the top ribbon, press Insert. 
Click on the Table button. 
Either uses the diagram to select the number of columns and rows you need, or click Insert 
Table and a dialog box will appear where you can specify the number of columns and rows. 
The blank table will now appear on the page. 
 
Q11. Create a following worksheet in MS-excel and save it with name ‘book1’. 

Roll no. Name marks 

1 N1 60 

2 N2 70 

3 N3 80 

4 N4 90 

5 N5 40 

6 N6 50 

7 N7 77 

8 N8 44 

9 N9 88 

10 N10 55 

 
Q12. Calculate the following things of a range (C2:C11) of data in the worksheet created in 
question no 10.   
The sum of the marks using AutoSum in a range of cells (C2:C11) 
 Average of the marks in a range of cells (C2:C11) 
Highest marks in a range of cells (C2:C11) 
Minimum marks in a range of cells (C2:C11) 
 
 



Q13 a) Describe various steps involved in the following   
To modify column width of a worksheet 
 To modify the row height of a worksheet   
To delete rows and columns of a worksheet 
 
Ans:- 
Steps of modify column width of worksheet:- 
Select the columns you want to modify. 
Click the Format command on the Home tab. The format drop-down menu appears. 
Select Column Width. Increasing the column width. 
The Column Width dialog box appears. Enter a specific measurement.  
Click OK. 
 
Steps of modify column height of a worksheet:- 
 
Locate and click the Select All button just below the name box to select every cell in 
the worksheet. 
Position the mouse over a row line so the cursor becomes a double arrow. 
Click and drag the mouse to increase or decrease the row height, then release the mouse when 
you are satisfied. 
 
Steps of delete rows and column in worksheet:- 
 
Right-click in a table cell, row, or column you want to delete. 
On the menu, click Delete Cells. 
To delete one cell, choose Shift cells left or Shift cells up. To delete the row, 
click Delete entire row. To delete the column, click Delete entire column. 
Q13 b) Describe following terms in the worksheet  
Absolute reference and relate 
ve reference in formula? 
 
There are two types of cell references: relative and absolute. Relative and absolute 
references behave differently when copied and filled to other cells. Relative references change 
when a formula is copied to another cell. Absolute references, on the other hand, remain 
constant no matter where they are copied. 
 
Cell address 
Cell address is an alphanumeric value used to identify a specific cell in a spreadsheet. Each cell 
reference contains one or more letters followed by a number. The letter or letters identify the 
column and the number represents the row. 
 
 
 
 



Q14. a) What tools are available to customize our PowerPoint presentation? 
 
               The tools are available to customize our PowerPoint presentation are:- 
Persecutor. Persecutor is a tool used by designers to create 3D images on PowerPoint 
presentations. ... 
Pivot Viewer. The Silver light Pivot Viewer is yet another tool frequently used by PowerPoint 
presentation designers. ... 
Autodesk 3DS Max. ... 
Visual Bee PowerPoint Add-In. ... 
Smart Art. ... 
Animations and Transitions. ... 
 
Q14 b) Write the steps for the following action for creation of power point presentation  
Open a Blank presentation? 
 
Steps of open a blank a document:- 
If you already have a file open in Word. 
You can create a new document by clicking File>New.  
You can also use the shortcut Ctrl+N (Commanding for Mac).  
To open a blank document, double-click the blank document option. 
 
Save the presentation as Lab1.pptx. 
               Steps to save the presentation:- 
To save the presentation goes to the file. 
Click on save as option. 
And save the presentation giving the name “Lab1.pptx.” 
 
Add a Title to the first slide: the name of your college  
Steps of add a title to the slide:- 
 Go to the first slide of presentation. 
Add the title name “abs college”. 
And save it by press “curls”. 
 
Type your first name and last name in the Subtitle section 
Steps of type first name and last name in the subtitle section. 
There are many free software packages (such as Aegis or Subtitle Workshop), that allow you to 
type in the subtitles yourself and lock them to a specific time code (e.g. 00:45-00:51). There is a 
thing you should keep in mind – adding the subtitles manually is a very time-consuming 
process. Moreover, you will have to dedicate some time to learn the interface and shortcuts of 
the software of your choice. 
Add a New Slide which has a Title and Content. 
Steps of add a new slide:- 
In the slide preview pane on the left, left-click with your mouse in-between two slides where 
you want to insert a slide. 



In the PowerPoint Ribbon, on the Home or Insert tab, click the New Slide option. 
In the drop-down menu that opens, select the type of slide to insert. 
 
Q15. Write steps for creation of a set of PowerPoint slides that demonstrates your skill to use 
the tools of PowerPoint. It should include the following things? 
 
 Title slide &bullet list Inserting Excel Sheet 
Clip art and Text 
Slide show effects 
Click the Start button. 
Click All Programs option from the menu. 
Search for Microsoft Office from the sub menu and click it. 
Search for Microsoft PowerPoint from the submenu and click it. 
Go to the “paragraph “icon and select the bullet where you want. 
To insert clip art and text go to the insert tab and click on clip art and choose the picture you 
want to appear on page. 
And then to slide show effect select the entire slide and go to the “format “and select the slide 
show effect .and click on that. 
 
 
 
 
Q16. What is the difference between Machine Language and High Level Language? 
 
 
 

s.no. Machine language High level language 

1. It is a machine friendly language. It is programmer friendly language. 

2. Machine language is high memory 
efficient. 

High level language is less memory efficient. 

3. It is tough to understand. It is easy to understand. 

4. It is complex to debug comparatively. It is simple to debug. 

5. It is complex to maintain 
comparatively. 

It is simple to maintain 

 
 
Q17. Discuss about different data types of C programming Language? 
 
To use any language in communication (to write/to speak), we need to understand its grammar 
first.  In the case of a programming language like C, the scenario is same as in the case of a 
communication language. We need to understand the grammar of C programming language 
first. So here begins:- 
Here are 4 data types in C language. They are:- 



 
Int – This data type is used to define an integer number (-….-3,-2,-1, 0, 1, 2, 3….). A single 
integer occupies 2 bytes. 
Char – Used to define characters. A single character occupies 1 byte. 
Float – Used to define floating point number(single precision). Occupies 4 bytes. 
Double – Used for double precision floating point numbers (double precision). Occupies 8 
bytes. 
 
Q18. Find the output of the following expressions? 
  
X=20/5*2+30-5 
 x=30 
 
Y=30 – (40/10+6) +10  
 y=30 
 
Z= 40*2/10-2+10  
Z=16 
 
 
Q19. Describe the syntax of the following statements? 
 
 
If – else statement syntax:- 
if (test expression)  
{ 
   // statements to be executed if the test expression is true 
} 
 
For loop- 
for (initialization Statement; testExpression; updateStatement) 
{ 
    // statements inside the body of loop 
} 
 
While loop 
Syntax 
While (condition test) 
{ 
      //Statements to be executed repeatedly  
      // Increment (++) or Decrement (--) Operation 
} 
 



Do-while loop - A do...while loop is similar to a while loop, except the fact that it is guaranteed 
to execute at least one time. 
 
while (testExpression)  
{ 
    // statements inside the body of the loop  
 
Q20. Find the output of the following program segments? 

a b c 

#include <stdio.h>  
int main()  
{  
int i;  
for (i=1; i<2; i++)  
{  
printf( "IMS Ghaziabad\n");  
}  
}  
 
 
 

#include <stdio.h>  
int main()  
{  
int i = 1;  
while ( i <= 2 )  
{  
printf( "IMS Ghaziabad\n");  
i = i + 1;  
}  
}  

 #include <stdio.h>  
void main()  
{  
int a = 10, b=100;  
if( a > b )  
printf( "Largest number is 
%d\n”, a);  
else  
print( "Largest number is 
%d\n”, b);  
} 

  
IMS Ghaziabad   

IMS Ghaziabad 
IMS Ghaziabad 
 

Compilation failed due to 
following error(s). 
 
main’s: In function ‘main’: 
main.c:14:9: warning: missing 
terminating " character 
 printf( "Largest number is 
%d\n”, a); 
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1-What are the different types of networks? 
 
    A computer network is a group of computers connected with each other    through a 
transmission medium such as cable, wire etc. In this guide, we will discuss the types of 
computer networks in detail. 

 
There are mainly three types of computer networks based on their size: 
1. Local Area Network (LAN) 
2. Metropolitan Area Network (MAN) 
3. Wide area network (WAN) 
LOCAL AREA NETWORK 
Local area network is a group of computers connected with each other in small places such as 
school, hospital, apartment etc. 
 
2. LAN is secure because there is no outside connection with the local area network thus the 
data which is shared is safe on the local area network and can’t be accessed outside. 
3. LAN due to their small size are considerably faster, their speed can range anywhere from 100 
to 100Mbps. 
4. LANs are not limited to wire connection; there is a new evolution to the LANs that allows 
local area network to work on a wireless connection. 
2. Metropolitan Area Network (MAN) 
MAN network covers larger area by connections LANs to a larger network of computers. In 
Metropolitan area network various Local area networks are connected with each other through 
telephone lines. The size of the Metropolitan area network is larger than LANs and smaller than 
WANs (wide area networks), a MANs covers the larger area of a city or town. 
 
 
3. Wide area network (WAN) 
Wide area network provides long distance transmission of data. The size of the WAN is larger 
than LAN and MAN. A WAN can cover country, continent or even a whole world. Internet 
connection is an example of WAN. Other examples of WAN are mobile broadband connections 
such as 3G, 4G etc. 
Explain the Shielded twisted pair (STP) and Unshielded twisted pair(UTP) 



Unshielded twisted-pair (UTP) cable is the most prevalent type of telecommunication medium 
in use today. Its frequency range is suitable for transmitting both data and voice. Therefore, 
these are most commonly used in telephone systems. 
A twisted pair consists of two insulated conductors (usually copper) in a twisted configuration. 
Color bands are used in plastic insulation for identification. In addition, colors also identify the 
specific conductors in a cable and to indicate which wires belong in pairs and how they relate to 
other pairs in a larger bundle. 

 
Shielded twisted-pair (STP) cable has an additional braided mesh coating or metal foil that 
wraps each set of insulated conductors. The metal casing intercepts the penetration 
of electromagnetic noise. It also can eradicate a phenomenon called crosstalk, which is the 
unwanted effect of one circuit (or channel) on another circuit (or channel). 

 
3-What is difference between baseband and broadband transmission? 
 

S.NO BROADBAND TRANSMISSION BASEBAND TRANSMISSION 



1. 

In broadband transmission, 
the type of signaling used is 
digital. 

In baseband transmission, the type of 
signaling used is analog. 

2. 
Baseband Transmission is 
bidirectional in nature. 

Baseband Transmission is unidirectional in 
nature. 

3. 
Signals can only travel over 
short distances. 

Signals can be travelled over long distances 
without being attenuated. 

4. 
It works well with bus 
topology. It is used with a bus as well as tree topology. 

5. 

In broadband transmission, 
Manchester and Differential 
Manchester encoding are 
used. 

Only PSK encoding is used. 
 
 
 

 
4. What is the difference between a hub, modem, router and a switch? 
 
  
-1. Repeater – A repeater operates at the physical layer. Its job is to regenerate the signal over 
the same network before the signal becomes too weak or corrupted so as to extend the length 
to which the signal can be transmitted over the same network. An important point to be noted 
about repeaters is that they do not amplify the signal. When the signal becomes weak, they 
copy the signal bit by bit and regenerate it at the original strength. It is a 2 port device.  
 
2. Hub – A hub is basically a multiport repeater. A hub connects multiple wires coming from 
different branches, for example, the connector in star topology which connects different 
stations. Hubs cannot filter data, so data packets are sent to all connected devices.  In other 
words, of all hosts connected through Hub remains one.  Also, they do not have intelligence to 
find out best path for data packets which leads to inefficiencies and wastage. 
 
 
3. Switch – A switch is a multiport bridge with a buffer and a design that can boost its efficiency 
(a large number of ports imply less traffic) and performance. A switch is a data link layer 
device. The switch can perform error checking before forwarding data that makes it very 



efficient as it does not forward packets that have errors and forward good packets selectively to 
correct port only.  In other words, switch divides.   
 
4. Routers – A router is a device like a switch that routes data packets based on their IP 
addresses. Router is mainly a Network Layer device. Routers normally connect LANs and WANs 
together and have a dynamically updating routing table based on which they make decisions on 
routing the data packets. Router divide broadcast domains of hosts connected through it. 
 
5. When you move the NIC cards from one PC to another PC, does the MAC address gets 
transferred as well? 
 When you move the NIC cards from one PC to another PC, does the MAC address gets 
transferred as well? Yes, that's because MAC addresses are hard-wired into the NIC circuitry, 
not the PC. This also means that a PC can have a different MAC address when another 
one replaced the NIC card. 
 
6. When troubleshooting computer network problems, what common hardware-related 
problems can occur? 
 
Network Troubleshooting 
In this tutorial, we are only concerned about the computer networking fault diagnosis and 
rectification. 
Based on the type of issue, we will discuss its troubleshooting steps and tips. 
Basic Network Problems 
Cable Problem: The cable which is used to connect two devices can get faulty, shortened or can 
be physically damaged. 
Connectivity Problem: The port or interface on which the device is connected or configured can 
be physically down or faulty due to which the source host will not be able to communicate with 
the destination host. 
Configuration Issue: Due to a wrong configuration, looping the IP, routing problem and other 
configuration issues, network fault may arise and the services will get affected. 
Software Issue: Owing to software compatibility issues and version mismatch, the transmission 
of IP data packets between the source and destination is interrupted. 
Traffic overload: If the link is over utilized then the capacity or traffic on a device is more than 
the carrying capacity of it and due to overload condition the device will start behaving 
abnormally. 
 
 7. In a network that contains two servers and twenty workstations, where is the best place to 
install an Anti-virus program? 
  
 The best solution is to install anti-virus on all the computers in the network. This will protect 
each device from the other in case some malicious user tries to insert a virus into the servers or 
legitimate users. 
 
  

https://www.geeksforgeeks.org/network-devices-hub-repeater-bridge-switch-router-gateways/#Routers


  
 
8. Define Static IP and Dynamic IP? Discuss the difference between IPV4 and IPV6. 
 IPV4 and IPV6 are internet protocol version 4 and internet protocol version 6, IP version 6 is the 
new version of Internet Protocol, which is way better than IP version 4 in terms of complexity and 
efficiency. 
 : 
 
1-IPv4 was the first version of IP. It was deployed for production in the ARPANET in 1983. Today 
it is most widely used IP version. It is used to identify devices on a network using an addressing 
system. 
The IPv4 uses a 32-bit address scheme allowing to store 2^32 addresses which is more than 4 
billion addresses. Till date, it is considered the primary Internet Protocol and carries 94% of 
Internet traffic. 
2-Ipv6- is the most recent version of the Internet Protocol. Internet Engineer Taskforce initiated 
it in early 1994. The design and development of that suite is now called IPv6. 
This new IP address version is being deployed to fulfill the need for more Internet addresses. It 
was aimed to resolve issues which are associated with IPv4. With 128-bit address space, it 
allows 340   unique address space. IPv6 also called  (Internet Protocol next generation). 
  
9. Discuss TCP/IP model in detail? 
 
TCP/IP Model helps you to determine how a specific computer should be connected to the 
internet and how data should be transmitted between them. It helps you to create a virtual 
network when multiple computer networks are connected together. The purpose of TCP/IP 
model is to allow communication over large distances. 
TCP/IP stands for Transmission Control Protocol/ Internet Protocol. TCP/IP Protocol Stack is 
specifically designed as a model to offer highly reliable and end-to-end byte stream over an 
unreliable internetwork. 
 
The functionality of the TCP IP model is divided into four layers, and each includes specific 
protocols. 
 
TCP/IP is a layered server architecture system in which each layer is defined according to a 
specific function to perform. 
All these four TCP/IP layers work collaboratively to transmit the data from one layer to another. 
`1-Application Layer. 
2-Transport Layer. 
3-Internet Layer. 
4-Network Interface. 
 
 
 
 



10. What is a Web Browser (Browser)? Give some example of browsers. 
 
 A web browser, or browser for short, is a computer software application that    enables a 
person to locate, retrieve and display content such as web pages, images, video, as well as 
other files on the World Wide Web. 
Browsers work because very web page, image, and video on the web has its own unique 
Uniform Resource Locator (URL), allowing the browser to identify the resource  
 
1-Google Chrome 
Chrome, created by internet giant Google, is the most popular browser in the USA, perceived by 
its computer and smart phone users as fast, secure, and reliable. There are also many options 
for customization in the shape of useful extensions and apps that can be downloaded for free 
from the Chrome Store.   
  
 
 
 
2-Apple Safari 
Safari is the default on Apple computers and phones, as well as other Apple devices. It's 
generally considered to be an efficient browser, its slick design being in keeping with the ethos 
of Apple. Originally developed for Macs, Safari has come to be a significant force in the mobiles 
market, due to the domination of I Phones and I Pads. Unlike some of the other browsers listed, 
Safari is exclusive to Apple  
 
3-Microsoft Internet Explorer and Edge 
Although it has been discontinued, Internet Explorer is worthy of a mention as it was the go-to 
browser in the early days of the internet revolution with usage share rising to 95% in 2003. 
However, its relatively slow start-up speed meant that many users turned to Chrome and 
Firefox in the years that followed. In 2015, Microsoft announced that Microsoft Edge would 
replace Internet Explorer as the default browser on Windows 10, making Internet Explorer   
4-Mozilla Firefox 
Unlike Chrome, Safari, Internet Explorer, and Microsoft Edge, Firefox is an open-source 
browser, created by community members of the Mozilla Foundation. It is perhaps the most 
customizable of the main browsers with many add-ons and extensions to choose from. In late 
2003, it had a u .s. A. 
5-Opera 
Another web browser worthy of mention is Opera, which is designed for Microsoft Windows, 
Android, I O S, m a c O S , and Linux operating systems. It has some interesting features and is 
generally considered to be a reliable option by many users. Many of its earlier features have 
gone on to be incorporated into rival browsers. It also has a distinct user interface. At the time 
of writing, Opera has a usage of just 2.28% but remains influential, albeit from the fringes. 
 
 
 



11. What is a search engine? Give example. 
 
A search engine is software accessed on the INTERNET that searches a DATABASE of 
information according to the user's QUERY. The engine provides a list of results that best match 
what the user is trying to find. Today, there are many different search engines available on the 
Internet, each with its own abilities and features. The first search engine ever developed is 
considered ARCHIE, which was used to search for FTP files, and the first text-based search 
engine is considered VERONICA. Currently, the most popular and well-known search engine 
is GOOGLE. Other popular search engines include AOL,ASK.COM, BAIDU, BING,DUCKDUCKGO 
and YAHOO 
. 
Google 

  
Google Search Engine is the best search engine in the world and it is also one of most popular 
products from Google. Almost 70 percent of the Search Engine market has been acquired by 
Google. The tech giant is always evolving and looking to improve the search engine algorithm to 
provide best results to the end-user. Although Google appears to be the biggest search engine, 
as of 2015 YouTube is now more popular than Google (on desktop computers). 
  
 
2. Bing 

   
Bing is Microsoft’s answer to Google and it was launched in 2009. Bing is the default search 
engine in Microsoft’s web browser. At Bing, they are always striving to make it a better search 
engine but it’s got a long way to go to give Google competition. Microsoft’s search engine 
provides different services including image, web and video search along with maps. Bing 
introduced Places (Google’s equivalent is Google My Business), this is a great platform for 
business to submit their details to optimize their search results. 
  
 
3. Yahoo  
 
Yahoo & Bing compete more with each other than with Google. A recent report on 
netmarketshare.com tells us that Yahoo have a market share of 7.68 percent. Although a leader 
as a free email provider, this is declining significantly though with their recent 
acknowledgement that User Details & Passwords where hacked last year. 
  
 
4.  Baidu   
 
Baidu is the most used search engine in China and was founded in Jan, 2000 by Chinese 
Entrepreneur, Eric Xu. This web search is made to deliver results for website, audio files and 

http://www.google.com/
http://www.google.co.uk/
http://www.bing.com/
http://yahoo.co.uk/
http://baidu.com/


images. It provides some other services including maps, news, cloud storage and much more. 
  
12. What is the Internet & WWW? What is the uses internet in our daily life? 
The internet is the wider network that allows computer networks around the world run by 
companies, governments, universities and other organisations to talk to one another. 
 
WWW-The World Wide Web (WWW), commonly known as the Web, is an information system 
where documents and other web resources are identified by Uniform Resource Locators (URLs, 
such as https://example.com/ ), which may be interlinked by hypertext, and are accessible over 
the Internet. 
  
The Internet innovated our daily life. ... Positive use of the Internet makes our lives easy and 
simple. The Internet provides us useful data, information, and knowledge for personal, social, 
and economic development and it is up to us to utilize our time on the World Wide Web in a 
productive manner 
 
1-online booking 
2-costructive communication 
3- Uses of the internet in effective education 
4-uses of the internet in the research. 
5-online banking 
6- Job searching. 
 
 
13. What is an Internet Service Provider? Give some example of ISP in India. 
 
Internet service provider (ISP)-  is an organization that provides services for accessing, using, or 
participating in the Internet. Internet service providers can be organized in various forms, such 
as commercial, community-owned, non-profit, or otherwise privately owned. 
 
 
 
 Give some example ISP. 
1-AIRTEL 
2-RELIANCE 
3-JIO 
4-BSNL 
 
 14. Discuss the difference between MAC address, IP address and Port address? 
 

. 

MAC Address stands 
for Media Access 
Control Address. 

IP Address stands 
for Internet 
Protocol Address. 

https://en.wikipedia.org/wiki/Internet
https://en.wikipedia.org/wiki/Community-owned
https://en.wikipedia.org/wiki/Non-profit
https://en.wikipedia.org/wiki/Privately_owned


 

MAC Address is a six 
byte hexadecimal 
address. 

IP Address is either 
four byte (IPv4) or 
six byte (IPv6) 
address. 

 

A device attached with 
MAC Address can 
retrieve by ARP 
protocol. 

A device attached 
with IP Address can 
retrieve by RARP 
protocol. 

 

NIC Card’s 
Manufacturer provides 
the MAC Address. 

Internet Service 
Provider provides IP 
Address. 

 

MAC Address is used to 
ensure the physical 
address of computer. 

IP Address is the 
logical address of 
the computer. 
 

 
  
15. How do we view my Internet browser's history? 
In a Microsoft Edge browser window, open the history menu using the keyboard shortcut 
ctrl+H.You can also access this menu with the following steps; 
 
First of all-ON YOUR COMPUTER-OPEN CHROME 
 
2Then-AT THE TOP RIGHT, CLICK MORE.   
 
3-CLICK HISTORY 
 
This menu allows you to view the pages you’ve visited in chronological order. 
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1. Elaborate the process & elements of Communication in detail 

through suitable examples. 

Communication process as such must be considered a continuous and 

dynamic inter-action, both affecting and being affected by many 

variables. 

(1) Sender: 
The person who intends to convey the message with the intention of passing information and 
ideas to others is known as sender or communicator. 
 
(2) Ideas: 
This is the subject matter of the communication. This may be an opinion, attitude, feelings, 
views, orders, or suggestions. 
 
(3) Encoding: 
Since the subject matter of communication is theoretical and intangible, its further passing 
requires use of certain symbols such as words, actions or pictures etc. Conversion of subject 
matter into these symbols is the process of encoding. 
 
(4) Communication Channel: 
The person who is interested in communicating has to choose the channel for sending the 
required information, ideas etc. This information is transmitted to the receiver through certain 
channels which may be either formal or informal. 
 
(5) Receiver: 
Receiver is the person who receives the message or for whom the message is meant for. It is 
the receiver who tries to understand the message in the best possible manner in achieving the 
desired objectives. 
(6) Decoding: 
 
The person who receives the message or symbol from the communicator tries to convert the 
same in such a way so that he may extract its meaning to his complete understanding. 
 
(7) Feedback: 
Feedback is the process of ensuring that the receiver has received the message and understood 
in the same sense as sender meant it. 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

CCA-104: Web 

Technologies 

Assignment 

 
 
 
 
 
 
 
 
 
 
 



Q1. Write html and css for the following using div   
 

For header and footer 

 
<! DOCTYPE html> 
<html lang="en"> 
<head> 
<title>CSS Template</title> 
<meta charset="utf-8"> 
<meta name="viewport" content="width=device-width, initial-scale=1"> 
<style> 
* { 
  box-sizing: border-box; 
} 
 
body { 
  font-family: Arial, Helvetica, sans-serif; 
} 
 
/* Style the header */ 
header { 
  background-color: #666; 
  padding: 30px; 
  text-align: center; 
  font-size: 35px; 
  color: white; 
} 
 
/* Create two columns/boxes that floats next to each other */ 
nav { 
  float: left; 
  width: 30%; 
  height: 300px; /* only for demonstration, should be removed */ 
  background: #ccc; 
  padding: 20px; 
} 
 
/* Style the list inside the menu */ 
nav ul { 
  list-style-type: none; 
  padding: 0; 
} 
 



article { 
  float: left; 
  padding: 20px; 
  width: 70%; 
  background-color: #f1f1f1; 
  height: 300px; /* only for demonstration, should be removed */ 
} 
 
/* Clear floats after the columns */ 
section:after { 
  content: ""; 
  display: table; 
  clear: both; 
} 
 
/* Style the footer */ 
footer { 
  background-color: #777; 
  padding: 10px; 
  text-align: center; 
  color: white; 
} 
 
/* Responsive layout - makes the two columns/boxes stack on top of each other instead of next 
to each other, on small screens */ 
@media (max-width: 600px) { 
  nav, article { 
    width: 100%; 
    height: auto; 
  } 
} 
</style> 
</head> 
<body> 
 
<h2>CSS Layout Float</h2> 
<p>In this example, we have created a header, two columns/boxes and a footer. On smaller 
screens, the columns will stack on top of each other.</p> 
<p>Resize the browser window to see the responsive effect (you will learn more about this in 
our next chapter - HTML Responsive.)</p> 
 
<header> 
  <h2>Cities</h2> 
</header> 



 
<section> 
  <nav> 
    <ul> 
      <li><a href="#">London</a></li> 
      <li><a href="#">Paris</a></li> 
      <li><a href="#">Tokyo</a></li> 
    </ul> 
  </nav> 
   
  <article> 
    <h1>London</h1> 
    <p>London is the capital city of England. It is the most populous city in the  United Kingdom, 
with a metropolitan area of over 13 million inhabitants.</p> 
    <p>Standing on the River Thames, London has been a major settlement for two millennia, its 
history going back to its founding by the Romans, who named it Londinium.</p> 
  </article> 
</section> 
 
<footer> 
  <p>Footer</p> 
</footer> 
 
</body> 
</html> 
 

For navigation 

 
<!DOCTYPE html> 
<html> 
<title>W3.CSS</title> 
<meta name="viewport" content="width=device-width, initial-scale=1"> 
<link rel="stylesheet" href="https://www.w3schools.com/w3css/4/w3.css"> 
<body> 
 
<div class="w3-container"> 
  <h2>Navigation Bars</h2> 
  <p>The <strong>w3-bar</strong> class is a container for displaying HTML elements 
horizontally.</p> 
  <p>The <strong>w3-bar-item</strong> class defines the container elements.</p> 
  <p>It it a perfect tool for creating navigation bars:</p> 
</div> 
 



<div class="w3-bar w3-black"> 
  <a href="#" class="w3-bar-item w3-button">Home</a> 
  <a href="#" class="w3-bar-item w3-button">Link 1</a> 
  <a href="#" class="w3-bar-item w3-button">Link 2</a> 
  <a href="#" class="w3-bar-item w3-button">Link 3</a> 
</div> 
 
</body> 
 

For content:- 
 

HTML 

<div class="shadowbox"> 
  <p>Here's a very interesting note displayed in a 
  lovely shadowed box.</p> 
</div> 

CSS 

.shadowbox { 
  width: 15em; 
  border: 1px solid #333; 
  box-shadow: 8px 8px 5px #444; 
  padding: 8px 12px; 
  background-image: linear-gradient(180deg, #fff, #ddd 
40%, #ccc); 
} 

 
 



For Sidebar 

Step 1) Add HTML: 

<!-- Side navigation --> 

<div class="sidenav"> 

  <a href="#">About</a> 

  <a href="#">Services</a> 

  <a href="#">Clients</a> 

  <a href="#">Contact</a> 

</div> 

 

<!-- Page content --> 

<div class="main"> 

  ... 

</div> 

Step 2) Add CSS: 

/* The sidebar menu */ 

.sidenav { 

  height: 100%; /* Full-height: remove this if you want 

"auto" height */ 

  width: 160px; /* Set the width of the sidebar */ 

  position: fixed; /* Fixed Sidebar (stay in place on 

scroll) */ 

  z-index: 1; /* Stay on top */ 

  top: 0; /* Stay at the top */ 

  left: 0; 

  background-color: #111; /* Black */ 

  overflow-x: hidden; /* Disable horizontal scroll */ 

  padding-top: 20px; 

} 

 



/* The navigation menu links */ 

.sidenav a { 

  padding: 6px 8px 6px 16px; 

  text-decoration: none; 

  font-size: 25px; 

  color: #818181; 

  display: block; 

} 

 

/* When you mouse over the navigation links, change their 

color */ 

.sidenav a:hover { 

  color: #f1f1f1; 

} 

 

/* Style page content */ 

.main { 

  margin-left: 160px; /* Same as the width of the sidebar 

*/ 

  padding: 0px 10px; 

} 

 

/* On smaller screens, where height is less than 450px, 

change the style of the sidebar (less padding and a 

smaller font size) */ 

@media screen and (max-height: 450px) { 

  .sidenav {padding-top: 15px;} 

  .sidenav a {font-size: 18px;} 

} 

 

 Q3. Write a Program to display count, from 5 to 15 using PHP loop as given 
below.  
 



<?php 
$count = 5; 
while($count <= 15) 
{ 
  echo $count; 
  echo "<br>" ; 
 
  $count++; 
} 
?> 

 

 Q4. Write a program in javascript for Unit Conversion from Kilometer (km) to 

Centimeter (cm). use of message box is necessary . 

<!DOCTYPE html> 
<html> 
<title>cm to Kilometers Length Converter</title> 
<body> 
 
<h2>Length Converter</h2> 
<p>Type a value in the cm field to convert the value to Kilometers:</p> 
 
<p> 
  <label>cm</label> 
  <input id="inputcm" type="number" placeholder="cm" 
oninput="LengthConverter(this.value)" 
onchange="LengthConverter(this.value)"> 
</p> 
<p>Kilometers: <span id="outputKilometers"></span></p> 
 
<script> 
function LengthConverter(valNum) { 



  
document.getElementById("outputKilometers").innerHTML=valNum/10
0000; 
} 
</script> 
</body> 
</html 
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